Word Processor: Tabular Presentation

Introduction, Creating tables, Adding table styles, Editing tables (viz. Inserting and
Deleting rows/columns, Changing row height and column width, Adding borders

and shading to a table, Resizing a table, Merging and Splitting cells, Cell alignment

Learning
Scope
(viz. Align left, right, center, justify)
Introduction

A table is a grid of rows and columns that intersect to form cells. The lines that mark the
cell boundaries are called gridlines. A row runs horizontally and a column runs vertically
in a table. Table can be used to represent data in an organised manner, making it visually
appealing and easy to read and understand. Various types of data such as pictures, graphics,

text, number, etc. can be inserted/written in

a cell.

A sample table is given below which shows the name of book, its corresponding author's name,
photograph and its type. You can see that each row gives the complete information about a
book and each column contains a specific type of information. In this chapter, we will learn
about creating, tables, entering data and editing tables in MS Word.
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(‘) Creating Tables in MS Word : ‘
‘ ; i . Wi nsert a tabj,

MS Word provides a feature that helps us to creale tables in :: document. We can i . ‘
by positioning the cursor at a required place in the dc')cumen

- To perform the above task, we have to take the following steps:

yU " _Step 1: Click at the position on the document i A rectangular arrang

want to insert a table. of data (numbers or g

Step 2: Click the 'Insert’ tab on the ribbon. text) in the form of rows
and columns is called a

Step 3: Select Table' and then ‘Insert Table' from the drop- ' ol
Matrix'.

Knowledge Corner 3

down list.
The 'Insert Table' dialog box will appear on the screen.
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Step 4: Enter the number of columns and rows in the dialog box.

Step 5: Finally, click 'OK'. i
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- Asalog Signal
Any type of signal or wave which is continuously varying in nature is
known as analog signal. It always gives output in the form of a patiern. By
observing the patiern of the output wave, we can conclude the resulis.
Some of the analog devices are thermomeler, meter scale, wall clock, etc
Digital Signal
A digital signal works on discrete data which states only two conditions,
ie, "True' and 'False’ or ‘High' and "Low’ or 'Present’ and ‘Absent’
ks I'hese states represent either | (one) or O (zero)
The mos! common digital deviges arv digital clocks, blood pressure
measuring machines, compulers, laptops, cell phones, etc
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A blank table is created at the desired place in the document as shown above.
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To insert table using grid, click on 'Table'
option under Tables' group on the 'Insert’
tab. Then hover over the mouse pointer

Here, 2x3 table selected.

It means that the table is

over the grid on the drop-down menu to

created with 2 columns and

highlight and select the number of rows

3 rows.

and columns.

.

Adding Table Styles

Once a table is created, MS Word now by default
provides you with various 'Table Styles' options to
choose table design of your choice. Select the style
as per your need. The table will be created with the
selected style as shown below.

Knowledge Comer* N
By default, the 'Table Tools' option
is not available on the ribbon area.
It is active only when a table is
selected.

« Header Row ! First Column

Any type of signal or wave which is continuously varying in nature is
known as analog signal. It always gives output in the form of a pattern. By
observing the pattern of the output wave, we can conclude the results

Some of the analog devices are thermometer, meter scale, wall clock, etc.

Digital Signal

A digital signal works on discrete data which states only two conditions,
ie, ‘True’ and ‘False’ or “High'and ‘Low’ or "Present’ and ‘Absent’.
These states represent either | (one) or 0 (zero).

The most common digital devices are digital clocks, blood pressure
measurmg machines, compulers. laptops, cell phones, etc
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Design' tab under "Tables Tool' option above the ribbon.

Entering Data in a Table

You can navigate in the table by using mouse, tab or arro
shown below:

The 'Table styles' option can also be accessed by selecting the table and then clicking on

You can enter data in a table by clicking on the desired cell and then entering the required data.

w keys. Now complete the table as

Word
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Analog Signal

- Any type of signal or wave which is co
known as analog signal. It always gives ou
observing the pattern of the output wave, we can conc

Some of the analog devices are thermometer, meler sca

ntinuously varying in nature is g
tput in the form of a pattern. By §°
lude the results. ¢

le, wall clock, etc.

o Digital Signal

A digital signal works on di
ie, ‘True' and ‘False’ or
These states represent cither | (one) 0
The most common digital devices are
5 measuring machines, computers, laptop:

screte data which states only two conditions,
High’and ‘Low’ or ‘Present’ and ‘Absent’.
r 0 (zero).

digital clocks, blood pressure

s, cell phones, etc.

The differences between Analog Signal and Digital Signal are:

1. It signifies a discrete signal (0 or 1).

7 1 Ilsimiﬁsaoonﬁnuom-ignlinmroﬂn. s i
i 2. It broadcasts the information in the s:g;u‘f " 2 It broadcasts the information in the binary
- form. form. .
>
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Page 15 of 57 2670 words [J§ _English (United States)
able and the width of the row changes

You will notice that the content get adjusted in the t
automatically as you enter the text.

(*) Editing Tables in MS Word

Once you have created a table,
MS Word, you can perform variety of tasks when you edit a table. S

« Inserting Rows in a Table

« Inserting Columns in a Table

« Deleting Rows or Columns

« Changing the Row Height in a Table

« Changing the Column Width in a Table

you can modify/rectify it in many ways as per your need. In
ome of these are as follows:

/Inserting a Row in a Table
< To add a row to an existing table, perform the following steps:
Step 1: Set the cursor in any cell in the row above or below where you want to insert a new

Y

row.
Step 2: Click the 'Layout’ tab on the ribbon under the "Table Tools' option.

.
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Step 3: Click on an appropriate option—'Insert Below' to insert a row below the selected row
or 'Insert Above' to insert a row above the selected row. Here, a row is inserted below
the selected cell of the row.

v
s o s o —
- The differences between Analog Signal and Digital Signal are: }
H
ot Analog Signal Digital Signal
[ 1. It signifies a continuous signal in wave form. 1 1. It signifies a discrete signal (0 or 1). l
e 2. 1t broadeasts the information in the signal | 2. It broadcasts the information in the binary |
o QUL - = form. I S . I
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v
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Now, you can add the content of the table as shown below.
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Similarly, we can insert a column in a row. Follow steps 1 and 2 and then click on the
appropriate option—'Insert Left' to insert a column to the left of the selected column or 'Insert
Right' to insert a column to the right of the selected column.

Deleting Rows or Columns
To delete a row/rows from an existing table, the following steps should be taken:

/Step 1: Set the cursor in any cell of the row/column to be deleted.

¥’ OR
( Select the row to be deleted.
o W s .
I'he differences between Analog Signal and Digital Signal are
.’-.
- Ananlog Signal Digital Signal
1. It signifies a continuous signal in wave form. 1, It signifies a discrete signal (0 or 1).
— | S — - e - — e S —— - e
- 2. It broadcasts the information in the signal 2. It broadcasts the information in the binary
o form form.
M 3. Analog signals are continuous ‘Sine’ waves. | 3. Digilal signals are in the form of ‘Square’ !
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Step 2: Click the 'Layout' tabs on the ribbon under the 'Table Tools option.

Step 3: Now, in 'Rows and Columns’ group, click ‘Delete’. A drop-down list opens.

ey 2= 10 Upda vord
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[ View Gridlines [ Eraser ,n,mw, fHspiitcels 325"  :HH HEE Tod  Cell  Ostal 8
& - Insert Right 3 Split Table & AutoFit - =) = [ pirection Margins ~ *
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Under the 'Delete’ option, the following four options are available:
i. Delete Cells: This option deletes the selected cell (or the cell on which e

cursor is placed). :
ii. Delete Columns: This option deletes the column on which the cursor is set or

the selected column(s). :
iii. Delete Rows: This option deletes the row on which the cursor is placed or -
selected row(s). A :

iv. Delete Table: This option deletes the entire table. 'Ju}llc,;,’

Step 4: Select 'Delete Rows' from the drop-down list.
Thus, the selected row/rows will be deleted. ‘
Columns can also be deleted in a similar way by choosing the 'Delete Column’ option
from the drop-down list under the 'Delete’ option. :

‘Note

The delete operation can also be carried out by setting the cursor on
the cell of the row/column on which the operation is to be carried out.
Further, on right-clicking, a drop-down menu opens. Now, by clicking on
the 'Delete’ option, another drop-down list opens to select the desired
operation.

- Changing the Row Height in a Table
" Perform the following steps for changing the height of a row:
Step 1: Select a cell or cells of the desired table. Here, complete table is selected as shown on
the following page.
Step 2: Click the "Layout’ tab from 'Table Tools' option. It will display the row height of the
selected row in the table in the 'Cell Size' group.
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Step 30 In the Helght' box, click on up arrow (A) or down Arrow button (¥) to change the
||
helght of the row as per your requirement, o b+
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Hhe row helght will be set shown above,

b

| Knowledge Corner

" To change the halght of the row, hover the mouse pointer over the row divider.
The mouse polnter changes to a double-headed arrow (4). Click and drag the
mouse to Increase or decrease the row helght,

ae timrmin SR - e SO

Changing the Column Width in o Table
Perform the following steps to change the width of a column:

Step 1 Select a cell or cells of the desired table. Here, column 'Class and Section’ is selected
av shown on the following page.

Step 20 Click the "Layout' tab from the “Table Tools” option. 1t will display the column width
in the 'Cell Size' group.

Word Processor: Tabular Pmnmlon_
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(v ) Adding Borders to a Table

. Step 1: Select the cell or cells of the table where a border is to be added.

Loy
Cy Setut- Y Do Tabte l.’ ] m.mu- || Marge Catia [[]_En_\_ = :'I‘H = A
00} View Griies [ rmses I 1) g eion o com D120 [HH s G
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.Tho Top Five Students of Clas Vh

< . Names Tecured
= 1 Kishan Raj B71/800
1 | Sumit Goyal 860/900
: 3 | Akash Mittal 876/900

4 Chandra Mohan 889/900
b 5| Doepak Sinha B66/900 :
Page 180057 2671 wonts [J§  Erglish (United Sistes) l- N - L Do

Step 3: In the 'Width' box, click on up arrow (4) or down arrow button (V) to change the
width of the column to a specific measurement of your choice. |

| G W AT LN T R $ i1 bind L
The Top Five Students of Class VI:
g Rank Name Marks Secured | Class & Section
1 Kishan Raj 871/900 6B
. 2 Sumit Goyal 860/900 6A
3 Akash Mittal 876/900 6C
4 Chandra Mohan 889/900 6D
6 Deepak Sinha 866/900 6C
Page 170f58 2670words [J§ Engiish (United States) I R - 1 4+ 100%

The column width will be set as per your need as shown above.

|‘
| To change the width of the column, hover the mouse pointer over the column
| divider. The mouse pointer changes to a double-headed arrow (#). Click and

' drag the mouse to increase or decrease the column width.

' Knowledge Corner

Adding borders to a cell or a complete table enhances the appearance of a table. To add

)
borders to a cell/cells in a table, perform the following steps:

Step 2: Click the 'Design’ tab from "Table Tools',
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Step Y Under the Borders group’, click on the dropdown arrow button (V) of the ‘Borders
option. From the dropdown list, select the desired border type (say, Outside Borders),

4

1
I &
s

The border will be added to the selected cells as shown below.
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tonk Name

W 1 Kishan Raj
" 2

2 l Sumil Goyal ]
o 3 Akash Mittal
o El Chandra Mohan
B 5 Deepak Sinha
e [Deepak Sinha ]

| ]

. The Top Five Students of Class VI,
Maorls Secured  Clow & Section

B71/900
860/900
876/900
889/900
866/900

-
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\pplying Shading to a Table

L Ihis function allows flling the background of a table with some pre-defined colours. By
- default, a table is created with gridlines in black and white. You can change the style of the
' table but to make it more attractive and appealing, you can apply shading to it. Perform the
- following steps to apply shading to a table:
Step 1 Select the cell/cells to which you want to apply shading. Here, the complete table is
selected as shown on the following page.
Sep 20 Click the Design’ tab from "Table Tools' option followed by the ‘Shading' option
available in "Table Styles’ group.
Step 3¢ Click on the dropdown arrow button (¥). Now, you can choose colour from the
“Theme colors” or click on ‘more colors’ option to get other colour options. A 'Colors'
dialog box appears on the screen,

Word Processor: Tabular Presentation 'l "III
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Step 4: Click the 'Standard’ option in the 'Colors’ dialog box.
Step 5: Select a colour from the colour palette.
Step 6:

Click the ‘Custom' option in the 'Colors’ dialog box and set the brightness of ; ;}_.
selected colour by adjusting the arrow () present on the screen. ,

Colors Colors

Standard = Custom Standard  Custom

Colors:

-~
{ )
n |

X

Colors:

Color model: |RGB .
L ;

Red: 201

New
Green: 255 t
Blue: 201
Current J
Step 7: Finally, click 'OK'".
',L‘q"‘llll O N E L | [ o IR i + 6 ¢ (_!
The Top Five Students of Class VI:
Rank Name Marks Secured  Class & Section |
1 Kishan Raj 871/900 6B
2 |[SumitGoyal | 860/900
3 Akash Mittal 876/900 6C
4 Chandra Mohan 889/900 6D ?
5 |DeepakSinha | 866/900
Page 180f 59 2689 words [J8 English (United States) ' m . E - 1 + 100%

The selected shading will be applied to the table as shown above.
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Resizing a Table
Resizing a table means decreasing or increasing the table size as per your need. We may change

the table size proportionately, length-wise or width-wise :
depending upon the data items. f owiedee L ”‘ :

To resize a table, perform the following steps:
Step 1: Click the table to be resized.
Step 2: Bring the mouse pointer at the bottom right headed arrow, it changes to a
of the table. The mouse pointer changes to a ‘plus’ sign.
double-headed arrow (resize handle, ) Just Try!

Step 3: Check and drag the table boundary diagonally. You can change the size of a table

The table will resize its length and breadth width-wise by dragging the 'plus’
proportionally. pointer horizontally.

Step 4: Release the mouse button.
The new size of the table will appear on the screen as shown below.

‘i- ] ) ] [ » l ] 0 “
e 5
x5 H
- H
~ - 1]
H
| 1]
. 1]
v ¥ ]
{

i i
'

While dragging the double

Y R PP
H

. »
The Top Five Students of Clow Vi
Rors Noms | MarinSecsed Ol fSetion

:) Merging and Splitting Cells
Merging cells means to combine two or more cells in a row or a column into a single cell.
On the other hand, splitting cells is the reverse of merging cells where a single cell is divided

into a number of small cells.

r Merging Cells

Perform the following to merge cells:
Step 1: Select the cells which are to be merged. Here, two cells of the first column are selected

as shown on the following page.
Step 2: Click on the ‘Layout’ tab under the "Table Tools' option.
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lable in the ‘Merge’ group-

Step 3. Select the option 'Merge Cells' avai
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The selected cells are merged into a single cell)) 3 o ’ ' .
Similarly, perform this operation on the "Total - ] ™
column of the table and modify it as given R
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Splitting Cells
Perform the following steps to split cell/cells:

Step 1: Select the cell/cells to split. Here, the cells under
the 'subjects’ column are selected.
Click on the 'Layout’ tab under the "Table Tools'
options which is present on the ribbon area.
Select the option 'Split Cells' available in 'Merge'
group. The 'Split cell' dialog box appears on the
screen.
Enter the number of columns and rows in the
Split Cells' dialog box to split the selected cells.

Finally, click OK.

Step 2:

Step 3:

Step 4:

Step 5:

5

=

- Knowledge Corner

Splitting of cells increases the
number of sub-cells within thg
selected cell/cells. i
Merging of cells combines
many cells that have been
selected for creating a single
cell. 3

[ Select- [ Draw Table Jo®) [ insert Below = Merge Cefls | ]
(5 v Grines s oo Dmerion RGN s
[ Properdes S ‘I\E::: H insert Right  ES Split Table =5 Ao - Ahgn.mem Dfu @
Tabie Draw Rows & Columns Merge Cell Size 3 -~ Sp“[ Ce“S ? x ,
L R ol 1 - Split Cells [ R S S ok e |
' Split the current cell into muitiple Number of EOlumﬂSj li :
cells e — ] |
b e Name " Totgd | Number of goves [?- E|
- | 3 }
‘Akuuh Jaiswal B Sp“uing 0’ Ce"S Merge cells before sw' . i |
Amit Mishra | - 1
Sanjay Goyal g [ OK _} ¢ L{
Sumit Dayal : —— . :

Nolad 2775 words

8 Inglsh (Unned Suates)

100%

54 rlCSl-L Computer Studies—6




. - [ ] L] L ] 3
N ) Total a
| Ak Saiwwal 1" :
- ) 5
ﬂ-nm_?l;;;i 7 =2
! Sumit Gayal i %

The selected cells are split (as shown in the snippet of the table given above).

Now, enter the data values and complete the table as shown below:

- - - — = i
t Name Subjecta Total
Pt =i gl [ Thywos | Chonmstry | Diology % A
3 | Akash Jaiswal LT &Y Vi 208 i ]
| Amit Mishra 8 ) NN S
Samay Gayal 86 N4 20 260
Sumit Dayal [ 88 9 | an
e ‘ SR N > W, s s DOER i e %
e L S | QN —— .-l- ] » ‘oos

Cell Alignment

The term ‘alignment’ defines the positioning of data/texts/documents, placed within a page or
the boundary of a cell. The text can be aligned along with the edge of a page or a cell. There
are four different types of alignment. They are:

(a) Align Left : It aligns the texts with left margin of the cell/page.

(b) Center : It aligns the contents on the center of cell/page.
(c) Align Right : It aligns the texts with right margin of the cell/page.
(d) Justify : It distributes the texts evenly between the margins.

X ﬁ o B L= .
ﬁ\ Bookman Olc=[12 = A" A" Aa- # W=== AaBbCeDc| AaBbCeDe AalbhC( | -l
Pa-ﬂe & B J U-asbeXx, X A-Y-.A- 'T ] : bl q 1 Normal § % No Spac.. Heading 1 Edit-{ng
Cliphoard Font > Paragrdph ™~ Styles " -~
Left align —J — Justify
Center align Right align

Create and enter the data into the table as shown below:

]

!
Ny caR el
BN B

Deepak Patel ~ KG/234/10 12/01/2010 By default, the text entered
Amit Gulati  KG/142/09 15/02/2009 In the table Is left-aligned.

B e e e )
Sunita Gondal KG/185/10 18/04/2010

All left align
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Suppase, you want 10 edit the table as -

* headings of the 1able: Center align
* contents of columns 2 and 3 Right align
Now, perform the following ste
Step 15 Select row 1 mlh!mmr:c Under ‘Home' tab on the ribbon, in the pangupl"
select ‘center align option. h
Step 2: Now, select the contents of columns 2 and 3. Click 'Right’ align
‘Paragraph’ group under ‘Home tab’.
The table is edited as shown below:

12/01/2010

 Deepa E T UR T |
Amit Gulati | KG/142/09 150212009 |
' Sunita Gondal = KG/185/10 18/04/2010
I IL_-———-Rnghtnugn—————I
Left align

Important options used in MS Word with the Shortcut Keys

_ 'Tc;pcnlnewdocﬁmcm o
Open To open an existing document > Cul+ O
Save To save an cxisting/opéncd document w Cffl_ +S
Print 'Togcuhlrdcopyofadocumentlﬁlc %
Print Preview To view a document before printing it
Cut Tocuundmovub!ockoftatﬁomoncplmtoanother 2
Cnyy 'I‘omnkcaduplicntccopyofablockofm:l
Paste Touunchaduphaucopyofablockoftatatthcdairedlocaﬂon Ctrl+\" ,
Undo To cancel the previous action taken K Ctr! +Z
Redo  To revert the action taken by the Undo button  |cuex
 Font To change the appearance of the text | + Shift
Font Size To change the size of the text -P
Bold To highlight the text b
Jtalic To change the text to italic form F
Underline To draw a line below the text 2 Taasu o
L

Align Text Left  To align the text at the left indent
Center Text To align the text at the center of the document
Align Text Right To align the text at the right indent

Justify To align the text from either side of the margins
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A Chapter at a Glance

e

‘ Qubie is a grid of wws and columns that intersect to form cells,
-+ The lines that mark the cell boundaries are called gridlines.
<.+ A row runs horizontally and a column runs vertically. /7 #’

~ + Atable can be insefttd by Insert —» Tables —» Insert Table.

« Once a table is inserted, MS Word by default shows various tabte style tmﬁpﬁw for the
user to choose.

+ A table in MS Word can be edited viz. inserting and deleting rowslcoimm CMW row
height and column width in a table.

» The height of the rows and the width of the columns can be changed in a table, using
(¥) or (A) button from cell size area, present in the ribbon.

f ¢ Table can be presented In an attractive manner by adding borders and shading.

‘ w1 erging cells means combining more than one cell into a 'single cefl.‘z g W e

v+ [Splitting cells is the reverse of merging cells. '

L .+ The resizing of a table means decreasing or increasing the table size proportionately.

] / An alignment defines the position of data/text placed within the boundary of a cell.
The texts can be aligned in four different ways viz. left, right, center, justify.

Students' Notes

...............................................................................................................................
..........................................................................................................................

5

;
£
¥
i
|
i:
%
1
3
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Objective
L. Choose the correct option:
1. Editing a table means
(a) Copying a table (b) Moving a table
(d) Creating a table

Updating a table
% A2 Which of the following is the correct term used for combining two Or mOre re
columns? g
(a) Iommg (b) Adding -_{€) Merging (d) SPhttln
3. Due to which of the following a table is created? -
Ab) Intersection of rows and columns

(a) Union of rows and columns
(c) Concatenation of rows and columns (d) None of these

4. Which of the following buttons is clicked under insert tab of the ribbon to insert a tabl
(d) Desxgn

(a) Format (b) Layout Table
5. Which of the following buttons is clicked from ‘Table Tools' to change the row "N.__.‘
of the selected table? 3
(a) View “(b) Layout (c) Insert (d) Design
II. State whether the following statements are True/False:

1. We can insert a row but not a column in a table.

2. We can delete a table along with its contents.
By dragging the two-headed arrow sideways, the column width can be

T
increased or decreased. T

4. Merging cells is the same as splitting cells.

3

. We can delete columns as well as rows in a table.
A cell is the smallest unit of a table which is formed using rows and columns.

T
F’

Press Ctrl + Y to cancel the previous action taken in the document.

o | 4.
4 8. The alignment means the position of data/text placed within the boundary
of a cell.
III. Fill in the blanks:
1. Table is defined as a grid of AOG)% and .. _“441:’:1 ;
Loblé ‘uﬂ 1

2. The 'Layout' tab for a table ribbon is available on the under the = | /00

option. |
3. A table is inserted in a document with respect to the position of the ("1}
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4. Rows state information that is represented ,af‘.'l ZO rf,a/z j in a table.
)-3
=’5. The lines that mark lhc cell boundaries are called ‘?5 udl nes
U

6. Click I n C”{ tab to create a table in the document.

7. E el Lz i ¥ Y of a table means increasmg or decreasing the table size in the document.

8. You can also insert nu J}' ol m "9 ln a table along with texts.

(
IV. Name the following:

) .
- o~ J. Two basic components of a table

(a) Rou i ) Colums
2. Three types of alignment

(a) .LEN‘ G P Cenler al, . @q)‘f oL

3. Three different tasks while editing tables

) Tbtibing ran/ o) 1M %”’” 9 kPA/ 400 .h.@.;rz/% Q/Duf@x
4. Three dJﬁ'erent optlgﬁs of addmg border to"a tatble Lablas

(@) op. Bonden ®) . Bollem. ‘Bofo[t’}f (c) /}M 80»‘(&[6%

V. Name the shortcut keys for the following tasks:

1. Align text left: : CM" % Highlight the text: C [hg, ,:f:):m L
\ 5!‘ J [
3. Jusify: : Ctgfp'f . J 4. To open a new document: . {3l o/

VI. Assertion and Reason based questions:
1. Solved
Assertion (A): Tables help us organise data in Word document. The table is like a matrix
with different rows and columns.
Reason (R): As MS Word is only responsible for carrying out mathematical operations
on numbers, use of tables assist the user in solving mathematical problems.
Based on the above discussion, choose an appropriate statement from the options given
below:
(a) Both A and R are true and R is the correct explanation of A.
(b) Both A and R are true and R is not the correct explanation of A.
(c) A is true but R is false.
(d) A is false but R is true.
(e) Both A and R are false,
Ans. (c) A is true but R is false.

2. Unsolved
Assertion (A): The number of cells (rows and columns) can be altered for storing more
data in a table.

Reason (R): MS Word requires the user to fix the number of rows and columns in a

Word Processor: Tabular Pmnuu:_
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’
1
e

ta
h::e while Creating it. To change the number of cells, the user has to delete the exjgy
€ and create a new one. F

Ecllf\ion the above discussion, choose an appropriate statement from the options '"Q-'
(@) Both A and R are true and R is the correct explanation of A.
(b) Both A and R are true and R is not the correct explanation of A.
V;?,A is true but R s false.
) A is false but R is true.
(€) Both A and R are false.

VIL Case Study based questions:
Solved

LA drawing Competition was organised in a school for different age groups on Childre;
Day. Aman asked for some help from his class teacher. The class teacher asked Am;
to prepare a table for the competition using various features such as splitting, mergin,
text alignment, shading, etc. as shown below: 4

— - S = SE === - — S 15

Drawing Competition ;

Group
| SL No. Name of the participants A T B C

S— ;-

—— — — i ————————————————————————————————————————————— }

He has some confusion in designing the above table correctly. Help him by answerin
the following questions: :
(a) What is the term used to divide a cell into the number of cells? |
(i) merging (ii) combining (iii) splitting (iv) piercing

(b) Which of the following shortcut keys will you select to center align the conten|
in the table? '

(i) Ctrl + C (i) Ctrl + D (iii) Ctrl + E (iv) Ctrl + B
(c) Which of the following tabs will you select to merge the selected cells?
(i) Home (ii) Design (iii) Insert (iv) Layout
(d) Which of the following options under 'Design’ tab will you use to apply colour |
the table?
(i) Shading (ii) Home (iii) Color (iv) Custom
Ans. (a) (iii) splitting (b) (iii) Ctrl + E (c) (iv) Layout (d) (i) Shading

2. Eshita had created a table containing details of her friends such as name, contact numbe
DOB, etc. Now, she wants to modify the table by adding and erasing one or m
rows and columns. Unfortunately, she has forgotten some of the commands req
perform these tasks. Help her to update the table by answering the following question

(a) Name a command to erase a row from the table. |

(b) Name a command to add a row into the table.

(c) Name a command to add a column into the table.

(d) Name a command to erase the entire table from the document, if she wa
create a new table,
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Ans. (a) Delete Rows (b) Insert Rows
(¢) Insert columns (d) Delete Table

Unsolved

1. While working in MS Word, using the mouse for selecting different options can
sometimes be quite cumbersome. Hence, it would be helpful to know some of the
shortcut keys that can be used for these operations such as UNDO, PRINT, OPEN,

etc. so that one can work faster to perform such tasks. Write down the shortcut keys
to perform the following:

(a) To cancel previous action. (/»)+

(b) To print the document. (! Wt P

(¢) To open an existing document. f}zﬁ + O

(d) To align the text from either side of the margins. C buo td

Subjective

v

L. Define the following:

II. Write all the steps to perform the following tasks:
1. Creating a table - 44

Deleting a column in a table ?_ ,l[? ,[{ g’

Inserting a row in a table{. 464 iy

Merging cells in a table f =2 . ~4

Changing the row height in a table P- 48 -4 Q

Adding borders to a table P-So-S1

oW oR oW
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®
In the Computer Lab

1. Prepare a table that comprises the marks of the first ten rank holders of your

The sample format is shown as:
1 Komal Sinha 881/900
2 Chandan Kishore 876/900
3 Sumit Mittal 865/900
4 Arjun Sandilya 844/900
Now, perform the following tasks:

(2) Heading of the table: Center align

(b) All ranks: Center align

(¢) Reduce the column width of column 'Name..
(d) Increase the column width of column Total.

Group Activity & Discussion

(Socially Useful Productive Work) [ 3% .

The teacher has assigned a Socially Useful Productive Work. So, R —=
you are making a project by creating a table that keeps the records et
of all the students helping 'Homeless People’. A sample table is
given for your guidance. The fund collected through this project
to hand over to a NGO. —

SNo.  Names School  Class Amount

i

1 Ashok Mitra Little Angels  VIII T 1870/-

2. Deepak Dayal Central Public IX 2 1285/- |
3.  Suman Gulati Arya Model VIII T 1450/- |
4 Prakhar Mittal Little Star X 21550/~

Now, make a group discussion to justify the usefulness of this noble assignment thre
which you are helping the society. :
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